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Abstract  
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users. 
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1  General Questions 

Return to Top 

1.1 What is iDoctor? 
IBM iDoctor for IBM i is a suite of software and associated services created to evaluate the health of your 
IBM i systems.  It can also analyze nmon data captured on VIOS. 
 
It includes these components for IBM i: PEX Analyzer, Job Watcher, Collection Services Investigator, 
Plan Cache Analyzer and Disk Watcher. These components are specifically geared towards pinpointing 
issues affecting system and application performance. 
 
There is also a consulting service available where our expert consultants analyze your system using the 
iDoctor software and provide you detailed results of their findings as well as subsequent 
recommendations. 
 
A link to our latest brochure: 
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Brochure2023.pdf 
 
A general overview presentation about iDoctor is available here: 
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctorShortOverview.pdf 
 

Return to General Questions 

1.2 How do I get iDoctor? 
iDoctor can be downloaded from either the iDoctor website or you can download iDoctor build images 
directly from our website: 
https://public.dhe.ibm.com/services/us/igsc/idoctor/web/ 
 
If you wish to download the server build save files for IBM i manually, they are available here:  
https://public.dhe.ibm.com/services/us/igsc/idoctor/web/ 

Return to General Questions 

1.3 Are trial periods available for the software? 
Yes, a 45-day trial is available for each of the "try-and-buy" iDoctor components. 
 
You must read and accept the license agreements:  
Job Watcher trial agreement and/or  
PEX Analyzer trial agreement. 
 
When filling out the registration form, please specify the system serial number and processor group for 
each system you wish to run the software on. 
 
Return to General Questions 

1.4 What does iDoctor cost? 
Some parts of iDoctor are free and cost nothing except you must agree to our license agreements.   
 
The free components include:  IBM i Explorer, Nmon and Knowledge Base. 
 

http://public.dhe.ibm.com/services/us/igsc/idoctor/html/services1.html
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Brochure2023.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctorShortOverview.pdf
https://www.ibm.com/products/idoctor
https://public.dhe.ibm.com/services/us/igsc/idoctor/web/
https://public.dhe.ibm.com/services/us/igsc/idoctor/web/
https://www14.software.ibm.com/cgi-bin/weblap/lap.pl?li_formnum=L-RMCR-BDYUVZ&title=IBM%20iDoctor%20for%20IBM%20i%20Job%20Watcher%20Trial
https://www14.software.ibm.com/cgi-bin/weblap/lap.pl?li_formnum=L-RMCR-BDYUSJ&title=IBM%20iDoctor%20for%20IBM%20i%20PEX-Analyzer%20trial
https://www-03.ibm.com/systems/campaignmail/services/labservices/iDoctor/requestform.html
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsLicense.html
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All other iDoctor components are licensed under either Job Watcher (this includes Collection Services, 
Disk Watcher, and others) or PEX Analyzer. 
 
To receive a price quote on either or both components please fill out this form: 
https://www-03.ibm.com/systems/campaignmail/services/labservices/iDoctor/requestform.html 
 
iDoctor is sold via Technology Services Statements of Work (SOWs.)  Pricing will vary by geography and 
whether it is purchased via Business Partners.    
Return to General Questions 

1.5 Which tool should I use to analyze disk performance on 
IBM i? 

Typically, users should start with the Disk folder within the Collection Services Investigator component. 
This provides many views of disk performance on the system.   

 
Collection Services Investigator – Disk graphs (INTERMEDIATE mode) 
 
If more details are required, then PEX Analyzer provides a Physical disk I/O (PDIO) event analysis.  This 
captures a trace of every single I/O that occurred during the collection and provides similar reporting 
options. 
 
Disk Watcher is also available but is less frequently used by performance analysts due to some limitations 
of that component (it can miss I/Os during periods of high activity.) 
 
Return to General Questions 

1.6 What IBM i releases are currently being updated and 
supported? 

iDoctor updates at IBM i releases vs support are two different things that will vary depending upon if the 
customer has an IBM i service extension or not. 
 

https://www-03.ibm.com/systems/campaignmail/services/labservices/iDoctor/requestform.html
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Typically, iDoctor will stop updating the server builds on specific IBM i releases on or shortly after 
IBM officially drops support or PTF fixes for an IBM i release.  This means that iDoctor server builds will 
no longer be made for those older releases but are still supported if the customer has a service 
extension.     
 
For more information on IBM i release life cycle visit:  https://www.ibm.com/support/pages/release-life-
cycle 
 
This table summarizes the various iDoctor components and IBM i releases that are being updated, 
supported (with or without a service extension) and available.   
  

Component Supported 

 

Supported 

(With service 
extension) 

 

Updated Available 

 

PEX Analyzer 7.3 and higher 
(7.3+) 

7.2 and higher 
(7.2+) 

7.3+ 5.2+ 

Job Watcher 7.3+ 7.2+ 7.3+ 5.2+ 

Collection 
Services 
Investigator 

7.3+ 7.2+ 7.3+ 5.3+ 

Disk Watcher 7.3+ 7.2+ 7.3+ 5.4+ 

Plan Cache 
Analyzer 

7.3+ 7.2+ 7.3+ 6.1+ 

IBM i Explorer Not supported  Not supported  7.3+ 5.4+ 

  
Note #1: Server builds are currently only updated at 7.3 and higher.  Some functions may still work at 
older releases but are no longer tested.  
 
Note #2:  To avoid problems, when using iDoctor at releases where the server builds are no longer being 
updated you will need to download and install the server builds last released from the  
Unsupported releases page on our website.  At 7.3 and up it is recommended to install the latest GUI 
build afterwards if you wish to receive support.  Any fixes will be done on the GUI side only where 
possible.  For 7.2 and older, do not install the latest GUI.   
 
Return to General Questions 

1.7 I have purchased PT1 Job Watcher. Where are my 
iDoctor Job Watcher keys? 

Sorry, buying PT1 (Performance Tools LPP) with the Job Watcher option does not entitle you to a license 
for iDoctor - Job Watcher.   

 
 

https://www.ibm.com/support/pages/release-life-cycle
https://www.ibm.com/support/pages/release-life-cycle
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsOld.html
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IBM offers two different GUIs for Job Watcher, and these are provided by different groups within IBM. To 
buy iDoctor - Job Watcher you may request a price quote. 
Return to General Questions 
 

1.8 Do you have an iDoctor 'app' for Andriod or Apple 
devices? 

No.    
 
Return to General Questions 

1.9 How do I check the version of the iDoctor GUI installed? 
The GUI version information is listed in the title bar of the iDoctor Main Window.  This includes the iDoctor 
GUI build number, the location and timestamp of the iDoctor.exe as well as the version of IBM i Access 
and SP level installed. When requesting help or submitting a bug report, please be sure to include a 
screenshot of this information. 
 

 
iDoctor Main Window Title Bar  
 
In this example, the client build number is 1617, the iDoctor.exe timestamp is June 5th, 2023 and IBM i 
ACS (with application package) is installed at version 1.1.0.27. 

Additional information about can be found by clicking the  button in the toolbar (or using the Help -> 
About menu. 

https://www-50.ibm.com/systems/campaignmail/services/labservices/iDoctor/requestform.html
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iDoctor Properties  
 
Return to General Questions 

1.10 How do I check the version of iDoctor installed on IBM 
i? 

1.10.1 From the GUI 
To check this from the GUI you will first need to launch any of the IBM i components and connect with the 
desired system.  Then to determine the build number right-click on the component icon (i.e. Job Watcher) 
within the tree and choose the Properties menu, 
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Job Watcher – Properties menu option 
 
Information about the GUI and server will be shown on the next screen. 

1.10.2 From the server 
Data area QIDRVRM contains the version information and exists in each iDoctor library (except 
QPLANCACHE and QMGTOOLS.) 
 
DSPDTAARA DTAARA(QIDRGUI/QIDRVRM)     
DSPDTAARA DTAARA(QIDRWCH/QIDRVRM)     
DSPDTAARA DTAARA(QIDRPA/QIDRVRM)     

  

1.10.3 For QMGTOOLS 
For the QMGTOOLS library run the commands: 
 
ADDLIBLE QMGTOOLS 
GO MG 
 
Then use option 12 (Display build date) 

 

Return to General Questions 

1.11 How do I get support for iDoctor? 
iDoctor is supported only via the iDoctor email address idoctor@us.ibm.com.  Send us a note and we will 
get back to you as soon as we can (typically 1 business day.). 
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Note:  iDoctor is NOT supported by the IBM i Global Support Center over the phone and we don’t use 
case numbers when working on iDoctor defects.   
Return to General Questions 

1.12 How do I get support for QMGTOOLs? 
QMGTOOLs is developed by a different team within IBM and is offered “as-is”.  Work with your IBM 
support contacts if you have any issues related to QMGTOOLS. 
 
Return to General Questions 

1.13 How do I get a graph’s data all on one screen to avoid 
scrolling?  

This depends on your preferences, there are a couple of different ways to do it or use a combination of 
both techniques. 
 
Option 1.  Increase the of bars per page preference to exceed the number of bars you are trying to 
graph.   
 
Use Edit -> Preferences -> Display  
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Preferences -> Display -> Bars per page settings 
 
Option 2.  Right-click the graph and use Graph definition->Set bars per page menu to desired value. 

 
Graph Definition -> Set bars per page menu 
 
Option 3.  If you have a huge # of bars and the above is not feasible or you don't like the way it looks, 
then you can click the clock icon and use larger time groupings. 
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Clicking the clock icon from the main window sets that as a preference, and from the data viewer that will 
rerun the SQL for the current view.  And by the way that preference is also in the above screenshot right 
above the bars per page setting called Default time range size.. 
 

  
Clock icon (menu) from the Main Window Toolbar 
 
For example, if you are in Job Watcher and have 1 second intervals and 100 bars per page but have 
10000 intervals you are trying to look at, picking something like 5 minutes is probably a better way to do it 
rather than scrolling through 100 pages. 
 
But the most bars you can see at one time is 5000 and even that does not really work that well in 
practice, due to limits with the graphing package and the fact most screen resolutions cannot show every 
bar in that case anyway (the # of pixels in the monitor is not high enough). 
 
Return to General Questions 
 
 

1.14 How do I zoom in and out on a graph? 
There isn't a zoom in menu option for graphs.  The zoom in process is click AND HOLD down the left 
mouse button somewhere on the graph (on white space not on a bar or line).  Then move the mouse to 
the right (for vertical bars) or down (horizontal bars) to create a selection, then release the left mouse 
button. 
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Zoom-in example 
 
Note: The number of bars in the zoom selection must be greater than 3 for this to work.  This is just to 
prevent an accidental zoom in if someone clicks and holds too long. 
 
Once zoomed in, the zoom out process is right-click the graph and use the Zoom Out menu. 
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Zoom-out example 
 
Return to General Questions 

1.15 What build level combinations should I install? 
Generally, we recommend installing the latest client and server builds on all systems you wish to run 
iDoctor on.  This is the environment where the iDoctor team will be best able to assist you in the event of 
a problem or you are needing a fix. 
 
It is not recommended to run for example a very old client with newer server builds or vice versa.  
However, builds that were released on similar dates should mostly work correctly but some problems may 
exist and are sometimes difficult to diagnose or predict. 
 
Return to General Questions 

 

1.16 How do I report problems with the tools? 
All issues are handled via the email address idoctor@us.ibm.com. 
 
To report a problem, you can click the Help icon in the main window toolbar, then click the Report 
problem button in the resulting window.  This will open your default email client and prepare to send 
information to IBM.  Additionally, if it is an install problem, please include the setup log file and job log if 
available.   
 

mailto:idoctor@us.ibm.com
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Be sure to include a brief description of the problem. Please include screenshots if possible. Use Alt-Print 
Screen to copy an image of the current screen to the Windows clipboard. 
 
When including screenshots of graphs or tables do not crop them as additional debug information is 
included in the status bar when viewing reports about where the report exits in the iDoctor report 
databases. 
 

 

Return to General Questions 

 

1.17 How do I transfer my IBM i connections and other 
iDoctor preferences to a new computer? 

1.17.1 For IBM i Connections: 
1) Right-click anywhere within the list of IBM i connections and use the Export Connections 

menu. 
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2) Specify a location for the export file and copy this to the new system.  This is a .reg windows 
file and contains Windows registry entries. 
 

3) On the new system, double-click the file after installing ACS with the windows-add on and your 
connections should appear. 

1.17.2 For iDoctor GUI preferences: 

1) With build 1562 or higher you can use the Export GUI Preferences… menu found in the IBM I 
Connections View.   

2) With older builds, since no built-in iDoctor option exists, you will need to run regedit 
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You need to have administrator level authority, say Yes if asked to run it. 
 
2) Navigate to Computer\HKEY_CURRENT_USER\IBM.AS400.Network\3RD PARTY 
EXTENSIONS\IBM.PEX 
 
3) Right-click that folder and click Export, specify a file name 
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Windows regedit export option for the root iDoctor preferences folder 
 
4) Double-click the file you specified on the new system to restore your desired preferences.   
 
Return to General Questions 

1.18 Where do I find information about system tasks? 
Details about some of the key system tasks are IBM i can be found here: 
https://www.ibm.com/support/pages/ibm-i-system-tasks-and-their-functions 
 
Return to General Questions 

1.19 The collection status column indicates files are missing.  
Should I be concerned? 

This depends on the message shown.  If the message contains “ERROR - CRITICAL FILES MISSING:”, 

then Yes, this means that the data/files listed cannot be located or contain no records and most normal 
analysis options won’t work. 

If the message contains “Ready - Missing:”, then this is probably normal and not cause for concern.  
For example, in Collection Services Investigator it is very common for some files to be missing such as 
QAPMLPARH or QAPMXSTGD.  This is just informing you that graphs requiring those files are not going 
to be available.  You can find out more on this by placing your mouse of the status column. 

https://www.ibm.com/support/pages/ibm-i-system-tasks-and-their-functions
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With some older builds such as 1508 and earlier you can try right clicking the library and use the “Clear 
Server Cache” menu option to resolve this.  This just makes sure the data is truly missing and is not 
because of incorrect or stale data in the collection’s cache.  

 
Return to General Questions 

1.20 Is iDoctor affected by log4j 1.X security vulnerability? 
No, but iDoctor requires IBM i Access Client Solutions (ACS) which is affected with version 1.1.8.6 and 
earlier.  Update to the latest version of ACS to resolve this issue. 

More information on this is available here:  https://www.ibm.com/support/pages/security-bulletin-ibm-i-
components-are-affected-cve-2021-4104-log4j-version-1x 

 

Return to General Questions 
 

1.21 How do I resolve the following ODBC, iDocJW.mdb file 
error when trying to look at data?   

File location is C:\PROGRAM FILES (X86)\IBM\IDOCTOR\iDocJW.mdb for data source local_idoctor_jw 

[Microsoft][ODBC Microsoft Access Driver] 1 Parameter wurden erwartet, aber es wurden zu wenig Parameter 

übergeben. 

State: 07002  
RC: -3010 

 
Errors like this sometimes happen after reinstalling iDoctor under C:\Program Files (x86)\IBM\iDoctor on 
Windows 10, and replacing a previous version and some of the original MDB files were not properly 
replaced and still remain. 
 
The easiest resolution for this problem is to reinstall in another location such as under C:\iDoctor or 
reinstall again being sure that iDoctor.exe is not already running by checking the Windows Task manager. 
 
Contact idoctor@us.ibm.com for more information. 
 
Return to General Questions 

1.22 How do I configure a secure SSL connection to the IBM 
i?  

This requires setting up a certificate and certificate authority on the IBM i using the DCM (Digital 
Certificate Manager tool).   The certificate must be downloaded to the PC using the ACS tool called 
cwbcossl.    

https://www.ibm.com/support/pages/security-bulletin-ibm-i-components-are-affected-cve-2021-4104-log4j-version-1x
https://www.ibm.com/support/pages/security-bulletin-ibm-i-components-are-affected-cve-2021-4104-log4j-version-1x
mailto:idoctor@us.ibm.com
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1.  Access DCM via this link: 

http://<yoursystem>:2001/QIBM/ICSS/Cert/Admin/qycucm1.ndm/main0 

 

2.  Follow these steps to create a CA if haven't already done and assign it to all the applications/host 
servers. 

https://www.ibm.com/support/pages/node/637503 

 

3.  Download the certificate to the PC via the cwbcossl tool.  Use password ca400 when prompted. 

https://www.ibm.com/support/pages/how-make-ssl-connection-ibm-i-acs-windows-application-package 

 

4.  On the IBM i (of course be careful about this) 

ENDHOSTSVR *ALL 

STRHOSTSVR *ALL 

 

5.  Check the box within iDoctor's edit connection to enable SSL 

 

 

6.  Afterwards, secure ODBC and remote command/program call connections to the IBM i should occur. 

https://www.ibm.com/support/pages/node/637503
https://www.ibm.com/support/pages/how-make-ssl-connection-ibm-i-acs-windows-application-package
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Note: These steps do not apply to iDoctor’s FTP connections.  For secure FTP connections you should 
use FTP method SSL (passive) and Tls12 like this: 

 

 

If you require assistance with this or have additional questions regarding DCM or ACS SSL configuration, 
we recommend contacting the ACS support team.  iDoctor support cannot resolve ACS error 25414 for 
you.  You will need to contact ACS support. 

 

More information on setting up the certificates correctly is here:  

https://www.ibm.com/support/pages/node/6350999 

 

Return to General Questions 

 

1.23 Will iDoctor impact my system’s performance? 
This depends on what the user intends to do with iDoctor and how healthy the system is.  

With the required PTFs applied, data harvesting is non-intrusive and light weight for JW/CS; PEX can be 
very heavy weight and we have seen it cause major performance issues; the user really needs to be 
careful and know what they are doing before collecting PEX. 

The analysis of the data is also rather light weight, but it does execute SQL queries so if you plan to do 
heavy analysis on a production system (that is under-sized or experiencing poor performance) then 
certainly running more queries is going to cause some load on the system.  Tip:  The data can be 
transferred to another system to do analysis there instead. 

 

Return to General Questions 

 

 

 

https://www.ibm.com/support/pages/node/6350999
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2 Installation Questions 

Return to Top 

2.1 What are the GUI installation requirements? 
The following are required to run the iDoctor GUI: 

A) Windows (Note: some users run iDoctor via Citrix/Linux KVM, Mac OS with Parallels or Remote 
Desktop) 

The GUI is supported on Windows 10 (or higher). It also runs on Windows 7 and Windows Server 
but is not regularly tested on those Windows operating systems and therefore not officially 
supported. 

Note: The user profile doing the installation must have administrator-level authority.  
Administrative level authority is not required to use iDoctor however once it is installed. 

B) If you wish to connect to IBM i systems, then the following must be installed: 

IBM i Access Client Solutions (ACS) base package and ACS Windows Application Package 
must BOTH be installed.  On the ACS download page be sure to download and install both and 
get the ACS Windows App Pkg English (64bit.).  More information about how to obtain ACS can 
be found here:   https://www.ibm.com/support/pages/node/683479 

 

Note: After downloading the IBMiAccess*.zip, unzip and expand \image64a folder 
and run setup.exe. 
  
  

https://www.ibm.com/resources/mrs/assets/DownloadList?source=swg-ia&lang=en_US
https://www.ibm.com/support/pages/node/683479
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For installation instructions see this video. 

C) For GUI builds older than 1655 (1654 or earlier):  

Microsoft Visual C++ 2012 Redistributable Package (install both the x86 and x64 options) 

For GUI builds at 1655 or higher: 

Microsoft Visual C++ 2022 Redistributable Package  (install both the x86 and x64 options) 

D) Microsoft .NET 4.5 (required if using Transfer methods other than the default - WININET) 

E) Java 1.5 or higher   

Note:  Some virus scanners or even Windows itself may prevent the opening of our downloads.  In some 
cases, you may get errors and need to temporarily disable these to open the download image. 
 
Return to Installation Questions 

https://mediacenter.ibm.com/media/How+to+Install+the+ACS+Windows+Application+Package/1_0ojfa1zk
http://www.microsoft.com/en-us/download/details.aspx?id=30679&cm_mc_uid=50341611747314521095637&cm_mc_sid_50200000=1452109563
https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170#visual-studio-2015-2017-2019-and-2022
http://www.microsoft.com/en-us/download/details.aspx?id=30653&cm_mc_uid=50341611747314521095637&cm_mc_sid_50200000=1452109563
https://java.com/en/
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2.2 What are the IBM i installation requirements? 
The following are required on the IBM i: 

• IBM i 7.1 or higher (older releases are available but not supported or updated)  See section 1.6 
for more information. 

• The required PTFs listed at http://public.dhe.ibm.com/services/us/igsc/idoctor/html/ptfs.html for 
the applicable IBM i release should be loaded and applied before collecting data.   

• The user profile performing the installation must have *SECOFR user class and special 
authorities *ALLOBJ and *SECADM. 

• The following host servers (identified by the SERVER parameter values on the STRHOSTSVR 
command) need to be running on the server:  *DATABASE, *RMTCMD, *SIGNON, *SRVMAP 

• System value QALWOBJRST must be *ALL or (*ALWSYSSTT and *ALWPGMADP) during 
installation. 

• Note: If English is not installed as the primary language, the user profiles used to connect to the 
server with should set their CCSID parameter value to 37 for best results.   

• Nmon requires OpenSSH option 1 (5733SC1) for the VIOS to IBM i disk mapping function. 

• Library QSYSINC must be installed (https://www.ibm.com/support/pages/not-able-find-library-
qsysinc) 

Return to Installation Questions 

 

2.3 How do I install iDoctor? 
See the documentation (section 2.4)  and/or watch this video. 
 
Tip: Click the link below for additional information about options for obtaining QMGTOOLs. 
http://www-01.ibm.com/support/docview.wss?uid=nas8N1011297 
 
Return to Installation Questions 

 

2.4 After installation the iDoctor properties or data area 
QIDRVRM shows a different build date than what was 
listed in the GUI install program. Is this a problem? 

No. The server build date listed in the installer is the date the save file was added to the FTP site.  The 
contents of the save file may be older. 
 
If desired, the .txt files on our FTP site contains the true build date for each similarly named save files 
(.savf.)  
http://public.dhe.ibm.com/services/us/igsc/idoctor/web/ 
 
For example, file BA_V7R2.txt contains the true build date for BA_V7R2.savf which is the V7R2 QIDRGUI 
library (listed as base support in the iDoctor installation.) 

http://public.dhe.ibm.com/services/us/igsc/idoctor/html/ptfs.html
https://www.ibm.com/support/pages/not-able-find-library-qsysinc
https://www.ibm.com/support/pages/not-able-find-library-qsysinc
http://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctorV73.pdf
https://mediacenter.ibm.com/media/Installing%20iDoctor%20on%20an%20IBM%20i/1_t18tia7i
http://www-01.ibm.com/support/docview.wss?uid=nas8N1011297
http://public.dhe.ibm.com/services/us/igsc/idoctor/web/
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iDoctor FTP site listing 
 
Return to Installation Questions 

 

2.5 I need to save a copy of the install save files to my PC so 
I can install it later. How do I do that? 

Download the Full iDoctor Installation image which includes all the SAVFs. On the 1st screen of the 
installation, use the "Download image" option in order to use these SAVFs. Otherwise, the installer will 
attempt to download the latest from the FTP site which may not be what you want it to do (if FTP access 
is unavailable/etc.) 
 
Return to Installation Questions 

2.6 My installation failed. What should I do? 
First check the logfile from the install program. This is viewable using the Display setup log button within 
the install program after selecting the desired entry in the list. Common problems are: host servers not 
started on the server, QALWOBJRST system value is not set to *ALL or FTP server is not started or not 
configured properly. 
 

http://public.dhe.ibm.com/services/us/igsc/idoctor/iDocInstallFull.exe
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Other issues that can occur are authority issues (lack of), or exit programs may be installed that are 
blocking or preventing ODBC or FTP processes from running correctly. 
 
If you cannot determine the cause and resolution to the problem, please send the logfile (and job log) 
to idoctor@us.ibm.com with a short description of the problem. The logfiles are retrievable from the 
C:\program files (x86)\ibm\idoctor\setuplogs directory on 64-bit Windows (or the C:\program 
files\ibm\idoctor directory on 32-bit Windows) after the installation has been closed.  The job logs can be 
retrieved using the Display job log button after selecting the desired failed entry. 
 
Return to Installation Questions 

2.7 What ports on the IBM i are needed for GUI Access? 
iDoctor port requirements are mostly the same as used by IBM i Access.  However, some port 
requirements will vary in practice based on the iDoctor GUI features used, but it is easiest to simply refer 
to this page. 

https://www.ibm.com/support/pages/tcpip-ports-required-ibm-i-access-and-related-functions 

 
In addition to the ports described in that document, some optional functions in the GUI utilize SSH.  If 
those functions are used, then SSH ports are needed as well.   This is usually port 22. 
 
If you are using IBM i cloud, then configuring an SSH tunnel using IBM i Access client solutions and 
additional ports will also be required.  Refer to the following support document for more details: 
 
https://www.ibm.com/support/pages/ssh-tunnel-configuration-use-ibm-i-access-client-solutions  
 
Return to Installation Questions 

 

2.8 I’m trying to install iDoctor on my IBM i but I’m getting an 
FTP error? 

Installing the server builds on an IBM i with the GUI install program does require the system has been 
configured to enable either SSL based FTP (port 990) or unsecure FTP (port 21.)    SSH based file 
transfer options are also available with recent builds.  
 
If an error is encountered, then the solution really depends on how the system is configured for FTP.  
There are options to use secure FTP: and possibly you only need to change how the connections are 
made within the installer. 
 
Download here: (the last option is best if the network environment has FTP restrictions since this avoids 
issues when downloading the SAVFs at install time) 
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadOptions.html  
 
Then run it and when you get to this screen try the options to Use SSL with Tls12 and passive mode are 
recommended but will only work if this has been enabled on the IBM i. 
 

mailto:idoctor@us.ibm.com
https://www.ibm.com/support/pages/tcpip-ports-required-ibm-i-access-and-related-functions
https://www.ibm.com/support/pages/ssh-tunnel-configuration-use-ibm-i-access-client-solutions
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadOptions.html
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2 SSH file transfer options are also available (either using Putty or Windows).  However, SSH password-
less authentication requires that the system has been setup correctly to allow this to work (not covered 
here.) 
 
If you can't send the save files with our installer then you will need to somehow get the SAVFs transferred 
to the IBM i (copy from the download image or from our website) and then use the manual install steps 
are listed in the documentation on our website: 
 
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/documentation.html  (section 2.5 – Manual install 
steps) 

 
Return to Installation Questions 

 

http://public.dhe.ibm.com/services/us/igsc/idoctor/html/documentation.html
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2.9 I want to install an older version of the server builds to go 
with client C0nnnn.  Where can I find that? 

On our website you can find a listing of several copies of client + server builds images that can be 
downloaded from the past.  They have a naming convention of iDocInstallFullC0nnnn.exe. 
 
https://public.dhe.ibm.com/services/us/igsc/idoctor/  

 
 
If the client build number you want to use is not listed above, then it would be recommended to use the 
most recent older version to install server builds only, and then if necessary, install the newer client only 
update.    
 
Client updates are also listed in the same directory above and have a naming convention of 
iDoctorClientC0nnnn.exe. 
 
Return to Installation Questions 
 

2.10 Where can I find the downloads for 7.1 and 7.2? 
We aren't regularly updating the server builds for these releases. 
For these releases you can download the last updates here: 
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsOld.html 

https://public.dhe.ibm.com/services/us/igsc/idoctor/
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsOld.html
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Optionally, and if desired after updating the server-side you can get on the latest client.  This requires that 
the user profile running the GUI have full rights to the QIDR* libraries like QIDRGUI.  This is because it 
will load several stored procedures that are outdated to the latest versions. 
If you lack ability to change objects in QIDRGUI then it won't work and you will have to stay on the older 
client from 2019. 
Return to Installation Questions 
 

2.11 How do I install iDoctor on the server without using the 
GUI installer? 

The manual install steps are listed in the documentation in section 2.5.  The steps used vary a bit 
depending on the release of the IBM I. 
 
For 7.1 only use the instructions in this file (section 2.5): 
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctorV73.pdf 
 
For 7.2 and higher use these steps (section 2.4): 
file:///C:/iDoctor/Documentation/Documentation/iDoctor_Overview.pdf 
 
The SAVFs used in the installation, can be downloaded from our website at: 
https://public.dhe.ibm.com/services/us/igsc/idoctor/web/ 
 
or see the documentation for other options:  
 
Return to Installation Questions 
 
 

2.12 Does installation require an IPL? 
No, but some required PTFs may require an IPL.  The performance PTFs fix problems is the OS and not 
with iDoctor so are generally required if you wish to collect performance data regardless on if iDoctor is 
installed or not. 
 
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/ptfs.html 
 
Return to Installation Questions 
 

2.13 How do I install iDoctor if I can’t use FTP? 
If you are not allowed to use FTP to do the installation, there are 3 choices with latest builds client 1583 
or higher (January 2023): 
 

1. The iDoctor Setup Wizard – Transfer Options panel includes a save file transfer method of SSH 
(PSCP.exe).   

https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctorV73.pdf
file:///C:/iDoctor/Documentation/Documentation/iDoctor_Overview.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/web/
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/ptfs.html
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This option requires that a 3rd-party tool called Putty is installed in the directory specified.  You can 
download putty here: 
https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html 
 
Note: The SSH server must be started.  You can use the iDoctor GUI’s IBM i Connections Popup menu 
option Terminal Sessions -> Start SSH server menu to start it or run command STRTCPSVR *SSHD. 
 

2. The iDoctor Setup Wizard – Transfer Options panel includes a save file transfer method of SSH 
(SCP.exe).   

https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html
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This method uses the Windows scp.exe command.  If SSH (OpenSSH) has not been installed on the PC 
then this option won’t work.  It also requires key-based rather than password-based authentication has 
been setup on every LPAR you wish to install iDoctor on.  If this has not been done you will be promted to 
enter a password everytime a file is transferred during installation.  While technically possible to install 
this way it will be a more painful process. 
 
The latest iDoctor GUI build 1583 or higher includes a menu option on the IBM i Connections View called 
Enable SSH key-based authentication.  This will use ssh-keygen.exe (on the PC) to create a public key 
file for you then transfer this key to the IBM i in the /home/<user>/.ssh/authorized_keys file which is 
required to allow passwordless authentication.  When choosing this method you will want to install the 
client first, use this menu option, then install the server. 
 
An example of the steps done when using Enable SSH key-based authentication are copied below 
where ‘mccargar’ is the user on both the PC and the IBM i:  
 
On the PC: 
ssh-keygen -t rsa -f "C:\Users\mccargar\.ssh\id_rsa.pub" -q -N “” 

 
On the IBM i: 
ADDENVVAR ENVVAR(QIBM_QSH_CMD_OUTPUT) VALUE('NONE') REPLACE(*YES) 
QSH CMD('mkdir /home/mccargar/') 
QSH CMD('mkdir /home/mccargar/.ssh/') 
QSH CMD('chown mccargar /home/mccargar/') 
QSH CMD('chmod 755 /home/mccargar/') 
QSH CMD('chown mccargar /home/mccargar/.ssh/') 
QSH CMD('chmod 700 /home/mccargar/.ssh/') 
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QSH CMD('rm /home/mccargar/.ssh/authorized_keys; touch -C 819 
/home/mccargar/.ssh/authorized_keys') 
 
ADDENVVAR ENVVAR(LINE) VALUE(‘contents of id_rsa.pub file on the PC goes here’) 
REPLACE(*YES) 
 
QSH CMD('echo "$LINE">> /home/mccargar/.ssh/authorized_keys') 
QSH CMD('chown mccargar /home/mccargar/.ssh/authorized_keys') 
QSH CMD('chmod 600 /home/mccargar/.ssh/authorized_keys') 
RMVENVVAR ENVVAR(LINE) 
RMVENVVAR ENVVAR(QIBM_QSH_CMD_OUTPUT) 
 
Note: The SSH server must be started.  You can use the iDoctor GUI’s IBM i Connections Popup menu 
option Terminal Sessions -> Start SSH server menu to start it or run command STRTCPSVR *SSHD. 
 
If you prefer to do this configuration manually you can read more about required steps here: 
https://www.ibm.com/support/pages/configuring-ibm-i-sshd-server-use-public-key-authentication 
 
 

3. If you don’t wish to use SSH the only other method is to install iDoctor manually using the Manual 
install steps in our documentation here:  
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Overview.pdf 

  
 
Return to Installation Questions 
 

2.14 What steps should I take when moving to a new release 
of IBM i? 

The iDoctor server build VRM must match the OS VRM.  Also, performance data from multiple releases 
should not exist in the same library.  Attempting to combine data from multiple releases in the same 
library will cause problems. 
 
You can check the VRM of the server builds installed by doing these commands: 
DSPDTAARA DTAARA(QIDRGUI/QIDRVRM)     
DSPDTAARA DTAARA(QIDRWCH/QIDRVRM)     
DSPDTAARA DTAARA(QIDRPA/QIDRVRM)     
 
Generally, you would update the OS first, then update the iDoctor server builds and any other needed 
changes based on the type of data being collected afterwards. 
 
Here are some general steps you could follow to do this: 
 

1. Download the latest version including the iDoctor server save file images here:  
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDocInstallFull.exe 

 

2. End the subsystem being used for iDoctor (i.e.  ENDSBS QIDRJW).  The subsystem is typically 

QIDRJW, but it’s possible this was changed from the default value.   To determine the subsystem 
and job queue used by iDoctor functions then run this command: 
DSPDTAARA DTAARA(QIDRGUI/QIDRJOBQ)    

 
3. Temporarily change system value QALWOBJRST to *ALL. 

 
4. Follow the instructions in chapter 2 to install iDoctor but be sure to keep the “Clear iDoctor 

libraries” checkbox checked, or you will have problems if any job has a lock on any iDoctor 

https://www.ibm.com/support/pages/configuring-ibm-i-sshd-server-use-public-key-authentication
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Overview.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDocInstallFull.exe
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library such as QIDRGUI, QIDRWCH or QIDRPA.  
https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Overview.pdf 

 

5. Install the required PTFs before collecting any data applicable to the release you are installing:  
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/ptfs.html   This may require an IPL.   

 

6. End Collection Services via 

A. GO PERFORM > OPT.2 > OPT.3 to End 

B. or from CSI GUI -> Right-click Collection Services Investigator -> End Collection Services 

 

7. If you wish to keep your old Collection Services or Job Watcher data, then copy it to a new 
library.   If you don’t, then clear the libraries that data resides in.   See also: 
https://www.ibm.com/support/pages/working-prior-release-collection-services-data-after-
upgrade 

 

8.  Start Collection Services  
A. GO PERFORM > OPT.2 >OPT.1 to Start 
B. or from CSI GUI -> Right-click Collection Services Investigator -> Start Collection Services 

 
9.  Start Job Watcher (optional) 

A. From JW GUI -> Right click Job Watcher > Start Monitor 
B. Or from server -> QIDRWCH/STRJWMON command as desired.  Note:  Some customers add 

this desired command to their IPL startup program. 
 

10. Note: Access codes will work regardless of the IBM i release installed (unless the release is 
V5R4 or older, the system serial number has changed, or they have expired).  You can reapply 
access codes using the QIDRGUI/ADDPRDACS command. 

 
 
  

 

 
 
 
Return to Installation Questions 
 

 

https://public.dhe.ibm.com/services/us/igsc/idoctor/iDoctor_Overview.pdf
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/ptfs.html
https://www.ibm.com/support/pages/working-prior-release-collection-services-data-after-upgrade
https://www.ibm.com/support/pages/working-prior-release-collection-services-data-after-upgrade
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3 Licensing Questions 

Return to Top 

3.1 I downloaded the software, but I'm getting an error 
saying I am not authorized to use it? 

You need an access code to activate the component on your system. In order to receive one, fill out the 
45-day trial registration form on the web site and specify your system serial number and OS 
Version/Release/Mod Level of the system you plan to install the software on. You will receive your access 
codes via e-mail generally within 1-business day of your request. Once you have received your access 
code(s), you can apply it to your system during the installation process or afterward when the GUI client 
asks for it. 
 
If you have already done this, make sure the system serial number and OS release specified in the 
request is correct. Also ensure that the correct (matching) OS version of iDoctor has been installed on the 
server. Data area QIDRVRM in library QIDRGUI can be examined to determine this. 

Return to Licensing Questions 

3.2 How do I determine the serial number and or processor 
group for my IBM i system? 

Enter the command DSPSYSVAL SYSVAL(QSRLNBR) and your system serial number will be displayed.  
Use the WRKLICINF command to display your processor group (2nd line of text in the results.) 
 
Note:  This information is also displayed in the GUI when you connect to your system on the iDoctor IBM i 
components window. 
 

 
 

Return to Licensing Questions 
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3.3 How long does my free trial period last? 
The trial period is 45-days. However, if for some reason you need more time to evaluate the software, 
send an e-mail stating the reason for the extension to idoctor@us.ibm.com and we will certainly consider 
it. 
Return to Licensing Questions 
 

3.4 What do I get if I purchase a PEX Analyzer license? 
More information on this can be found here:   
 
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/pa.html 
 
Return to Licensing Questions 
 

3.5 What do I get if I purchase a Job Watcher license? 
More information on this can be found here:   
 
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/JW.html 
 
Return to Licensing Questions 
 
 

3.6 I have a large system with multiple LPAR partitions.  Do I 
have to purchase a copy of the software for each of these 
partitions?  

No.  The iDoctor components are licensed by system serial number and OS release.  You purchase the 
service for each system serial number and you are then entitled to receive a copy of the software for each 
supported OS release you are running on that box. 
 
Return to Licensing Questions 
 

3.7 Are special discounts available for IBM Business 
Partners? 

Yes.  If you are an IBM Business Partner, e-mail idoctor@us.ibm.com or request a price quote and 
indicate you are a BP on the form to receive more information. 
 
Return to Licensing Questions 
 

mailto:idoctor@us.ibm.com
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/pa.html
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/JW.html
mailto:idoctor@us.ibm.com
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3.8 What is the difference between Job Watcher using 
iDoctor vs the Performance Tools (PDI, PT1 – JW 
option)? 

The iDoctor tools are developed by support (and sold by Lab Services). iDoctor is licensed by serial 
number on an annual basis.  
 
There are two licenses, one for Job Watcher (which includes Collection Services Investigator, Plan Cache 
Analyzer and Disk Watcher) and another for PEX Analyzer. iDoctor is a thick client application that runs 
on Windows. iDoctor is very rich in function and is used widely by IBM i performance experts in support 
and lab services.   The support is via email only (this address). 
 
The PT1 Job Watcher tools are developed and serviced like "normal" IBM products. The analysis GUI 
(Performance Data Investigator -- PDI) is browser-based. PDI includes high-level health indicators and 
analysis of Collection Services data for free with IBM i. The charged options are needed for analysis of 
Job Watcher and PEX data. 
 
The tools are similar in function but not equivalent. PDI has been adding features, but iDoctor has more 
detailed drill-down capability and other analysis features. 
 
If you buy iDoctor -Job Watcher you don't need to buy the PT1 - JW option or PT1.   
 
The Job Watcher data collector (STRJW) is included within IBM i and so if you just want to collect data 
and analyze yourself you don't need to buy either. 
 
Return to Licensing Questions 
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4 Common Problems 

Return to Top 

4.1 I downloaded the install image and when I try to run it I 
get the message 'This is not a valid Windows 
application'. Why? 

The install file was not downloaded completely. This may happen if you have a slow or unstable internet 
connection or the download was canceled before it could complete. Check the size of the file on the web 
page and compare it to the size of the file you have in order to verify the problem or attempt to download 
the file again. 
 
If you continue to have difficulties contact idoctor@us.ibm.com and we will try to help. 
 
Return to Common Problems 
 

4.2 How do I make secure connections to the IBM i using 
iDoctor and ACS? 

To make this happen you would need to ensure that both the IBM i side and the iDoctor (client) side of 
things are configured properly.  Within iDoctor’s IBM i Connection View by editing the connection you 
would need to enable FTP method, SSL protocol and Use SSL for IBM I Access connections options as 
shown below: 
 

mailto:idoctor@us.ibm.com
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Note: FTP is controlled via different processes than the Use SSL for IBM I Access connections option 
and you would only enable both if they are configured correctly on the IBM i. 
 
More information on configuring ACS to enable SSL (secure) connections can be found here: 
https://www.ibm.com/support/pages/how-make-ssl-connection-ibm-i-acs-windows-application-package 
 
Return to Common Problems 
 

4.3 Is there still a server version of iDoctor that works on 
V5R3, V5R4, V6R1, 7.1? 

Yes, all the older IBM i release iDoctor builds are here: 
 
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsOld.html 

 

Return to Common Problems 

 

4.4 IBM i connections cannot be added because IBM i 
Access for Windows or IBM Access Client Solutions with 
the Windows add-on are not installed? 

Connecting to an IBM i with iDoctor requires either: 

https://www.ibm.com/support/pages/how-make-ssl-connection-ibm-i-acs-windows-application-package
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsOld.html
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1) IBM i Access for Windows (only works on Windows versions earlier than Windows 10) 

2) IBM i Access Client Solutions (ACS) AND the ACS application package for windows.  The ACS 
application package is typically not installed and is usually the reason for this error. 

 
See the section on GUI installation requirements for more details. 
 
Return to Common Problems 
 

4.5 What are these QAIDRnnnnn files? 
These are iDoctor created SQL tables.  This is how the system names them since the table names are > 
10 characters.   
 
These files are created when you run an iDoctor analysis such the Collection summary analysis.  Any 
DDMF QAIDR* objects are iDoctor aliases.  If you have lots of aliases you might be on an older build as 
there should not be very many at all any more with recent builds as those all go in QTEMP now.   
 
These files all go in the SQL tables folder.  You can delete them by right-clicking the SQL tables folder 
and doing the delete option either the one under a single library or if you do it on the SQL tables under a 
component like Job Watcher, you can clear them off the entire system in one step if you want to.   
 
You can also view or delete them with the table search function in the GUI.   

 
Example of Table Search toolbar button  
 
Return to Common Problems 
 

4.6 How do I keep library filters separate between different 
components? 

In the Libraries pane with latest builds (updated Sept 25th, 2024) they are separate for each 
system/component by default. 

 
Return to Common Problems 
 

4.7 Why do I have ODBC errors relating to missing objects 
after upgrading the client but not the server? 

A user reported the following issue: 

I recently upgraded my client software, and now I’m facing an issue.  The error is referencing 
QIDRJWRI4 *PGM missing from QIDRGUI.  Please advise. 
iDoctor relies heavily on SQL stored procedures for many functions and these exist in library QIDRGUI.  
Normally when installing the server these are loaded.  In some cases when the client has been updated 
but not the server then these procedures need to be updated in the QIDRGUI library. The GUI will 
attempt to do this. 
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The default behavior for this is these SQL statements required to create the stored procedures are 
created in a text file and then FTP is used to send this file to the IFS where they are executed by the 
RUNSQLSTM command.  If your iDoctor connection settings are not correct and the FTP process fails, 
then this won’t happen, but instead the GUI will try to run the required SQL statements to create the 
stored procedures via a QZDASOINIT job. 
   
If problems persist then take a screen shot of the remote sql statement status view/ and related job log 
(right-click on it, display job log) if necessary and report this to idoctor@us.ibm.com for assistance. 
 
Return to Common Problems 
 

4.8 What objects and IFS folders does a user need access to 
in order to use iDoctor?  

For users that do not have full authorities on an IBM i they will require at a minimum the following: 
 

1. The user profile must be added to function group QIBM_SERVICE_TRACE. 
2. The user profile must be added to function group QIBM_SERVICE_JOB_WATCHER. 
3. The user profile must be added to function group QIBM_SERVICE_DISK_WATCHER. 
4. *ALL to library QIDRGUI. 
5. *ALL to file QAPEXDFN in library QUSRSYS.            
6. *ALL to file QAPYJWDFN in library QUSRSYS.            
7. *ALL to file QAPYDWDFN in library QUSRSYS.            
 
8. *ALL to files QAIDR* in libraries QGPL and QUSRSYS.   PLEASE NOTE: All files must exist 

(QUSRSYS/QAIDRCOLS, QUSRSYS/QAIDRLIBS, QUSRSYS/QAIDRJWM2, etc) which may 
require a full authority user, using all desired functions in the GUI you wish to let the other 
users use (such as the Monitors folder) prior to running the ADDIDRUSR command. 
 

9. *USE to commands ADDPEXDFN/RMVPEXDFN in library QSYS.           
10. *USE to commands ADDPEXFTR/RMVPEXFTR in library QSYS.                                                                          
11. *USE to commands ADDJWDFN/RMVJWDFN/STRJW in library QSYS.       
12. *USE to commands ADDDWDFN/RMVDWDFN/STRDW in library QSYS.                                                                      
13. *USE to commands SAVPFRCOL/STRPFRCOL/DLTPFRDTA in library QSYS. 
14. *USE to CS API QYPSRSCA in library QSYS.                                                                                       
15. *OBJEXIST *OBJMGT *OBJOPR *OBJREF *READ *EXECUTE to QAYPE*, QAPY* and QAPM* 

files in QSYS.              
16. *RWX to IFS path /QIBM/UserData/iDoctor and all subdirectories 
17. *RWX to IFS path /QIBM/ProdData/iDoctor and all subdirectories.     

 
Note: An administrator can grant these authorities by running the QIDRGUI/ADDIDRUSR command on 
your user profile. 
 
File list relating to #8 above as of September 30th, 2024: 

QGPL File  Description 

QAIDRJBSCD Scheduled jobs.  Under IBM I Explorer -> Work management -> Scheduled jobs 
folder.  Created by scheduling something in the GUI. 

QAIDRKEYS Keeps track of access codes if using multiple LPARs and Live partition mobility 
functions.  See IBM i connections view -> Apply keys menu to create this. 

 
 

QUSRSYS File Description 

QAIDRCNC1  Collections repository –old version. Can be deleted if using latest builds. 

QAIDRCNL1 Collections repository –old version. Can be deleted if using latest builds. 

QAIDRCOLS Collections repository – created by the installer (assuming install runs successfully)  
If not use CSI/JW root folder menu option -> Collections database -> Full rebuild 

mailto:idoctor@us.ibm.com
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menu option) 
 

QAIDRCSMGT  obsolete – can be deleted 

QAIDRDBKT   PEX Analyzer – disk response times mapping.   Use PEX – Rebuild disk response 
times mapping analysis option to create this.  Used by PDIO analysis. 
 

QAIDRDIRMN  IBM i Explorer -> Power -> Monitors file.  Created by visiting that folder. 

QAIDRDWM2 Disk Watcher monitors.  Created by visiting the Monitors folder and creating a DW 
monitor or using QIDRWCH/STRDWMON.  

QAIDRJWKB Knowledge base stuff.  Most probably aren’t using this. 

QAIDRJWM2 Job Watcher monitors.  Created by visiting the Monitors folder and creating a JW 
monitor or using QIDRWCH/STRJWMON.  

QAIDRJWRD  Job Watcher rule definitions.  Created by creating a rule using the Add Job Watcher 
Definition Wizard. 

QAIDRKBFLD Knowledge base stuff.  Most probably aren’t using this. 

QAIDRKBJW Knowledge base stuff.  Most probably aren’t using this. 

QAIDRLIBS  Collections repository – created by the installer (assuming install runs successfully)  
If not use CSI/JW root folder menu option -> Collections database -> Full rebuild 
menu option) 

QAIDRMSYS  Created by the Monitor Wizard when indicating on the 1st page you want to create a 
monitor using multiple LPARs. 

QAIDRPAM2 PEX Analyzer monitors.  Created by visiting the Monitors folder and creating a PEX 
monitor or using QIDRWCH/STRPAMON.  

QAIDRSF1 Keeps track of saved collection save files.  For the IBM i Explorer -> Saved 
collections folder.  Created by the Transfer Collection / Save Collection interface. 

QAIDRUSERS Knowledge base stuff.  Most probably aren’t using this. 

QAIDRXDFN FTP definitions.  - Created when creating a Monitor using that option to send data to 
another LPAR. 
 

 
 
Return to Common Problems 
 

4.9 What is the process when upgrading iDoctor to a new 
IBM i release?  

After upgrading the IBM i to a new release, the following actions should be taken: 
 

1. Install latest server builds matching the IBM i release.  These can be downloaded from here:  
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadOptions.html 

 
2. Install PTFs listed on our website that match the IBM i release or if you can't at least read and 

accept any risks by not doing so.   
- Example for 7.3:  

https://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsV7R3.html  
 

3. Do not try to collect new performance data in a library that contains previous release data.  
Rename this library or use a new library instead.  You will have lots of problems if you don't do 
this. 

 
4. Do NOT use the CVTPFRCOL command on performance data you wish to analyze with iDoctor.  

Doing so will cause problems.   
 

Return to Common Problems 
 

https://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadOptions.html
https://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsV7R3.html
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4.10 How do I grant a user without *ALLOBJ authority access 
to analyze not yet created Collection Services data in 
QPFRDATA?  

If Collection Services data is being captured in library QPFRDATA (for example) then you would need to 
do the following steps: 
 

1. Run command:  QIDRGUI/ADDIDRUSR YOURUSER 
 

2. End Collection Services 
 

3. You will need to either delete or save/copy all QAPM* files in QPFRDATA to another library if 
you wish to save your old data. 

 
4. Restart Collection Services. 

 
This would let user YOURUSER analyze new data collected on the IBM i.  This also would let them 
analyze new PEX, Job Watcher or Disk Watcher collections not yet created in any library that does not 
already exist and contain performance data. 
 
Return to Common Problems 
 

4.11 How do I grant a user without *ALLOBJ authority access 
to analyze performance data (PEX, CS, JW, etc.) in a 
library? 

The 1st step is to end all active performance collections that might be accessing any data in your library. 
Also end any iDoctor GUI sessions that might be accessing data in the library. 
Several commands will need to be ran to grant access to all performance data in library YOURLIB and 
user YOURUSER.  You will need to run these commands: 
 

- QIDRGUI/ADDIDRUSR YOURUSER 

- ENDPFRCOL 

- ENDSBS QIDRJW 

- ENDPEX 

- ENDJW 

- ENDDW 

- QSYS/GRTOBJAUT OBJ(YOURLIB/QAYPE*) OBJTYPE(*FILE) USER(YOURUSER) 
AUT(*OBJEXIST *OBJMGT *OBJOPR *OBJREF *READ *EXECUTE) REPLACE(*YES)   

- QSYS/GRTOBJAUT OBJ(YOURLIB/QAPM*) OBJTYPE(*FILE) USER(YOURUSER) 
AUT(*OBJEXIST *OBJMGT *OBJOPR *OBJREF *READ *EXECUTE) REPLACE(*YES)   

- QSYS/GRTOBJAUT OBJ(YOURLIB/QAPY*) OBJTYPE(*FILE) USER(YOURUSER) 
AUT(*OBJEXIST *OBJMGT *OBJOPR *OBJREF *READ *EXECUTE) REPLACE(*YES)   

- QSYS/GRTOBJAUT OBJ(YOURLIB/QAIDR*) OBJTYPE(*FILE) USER(YOURUSER) 
AUT(*OBJEXIST *OBJMGT *OBJOPR *OBJREF *READ *EXECUTE) REPLACE(*YES)   

- QSYS/GRTOBJAUT OBJ(YOURLIB/PEX*) OBJTYPE(*FILE) USER(YOURUSER) AUT(*OBJEXIST 
*OBJMGT *OBJOPR *OBJREF *READ *EXECUTE) REPLACE(*YES)   

- QSYS/GRTOBJAUT OBJ(YOURLIB/CS*) OBJTYPE(*FILE) USER(YOURUSER) AUT(*OBJEXIST 
*OBJMGT *OBJOPR *OBJREF *READ *EXECUTE) REPLACE(*YES)   
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- QSYS/GRTOBJAUT OBJ(YOURLIB/*ALL) OBJTYPE(*MGTCOL) USER(YOURUSER) 
AUT(*OBJEXIST *OBJMGT *OBJOPR *OBJREF *READ *EXECUTE) REPLACE(*YES)   

 
Note: With May 2023 builds or higher, you can use the General Functions -> System -> User profiles 
folder to grant a user access to a library.  Right-click the desired user and use the “Grant authority to use 
performance data in library…” menu option.  It will run the above GRTOBJAUT commands for you. 
 
Return to Common Problems 
 

4.12 How do I extract iDoctor data for use in Excel? 
First, it’s best to check and understand the preferences.  
 
Open the Preferences interface from the menu Edit -> Preferences, then click the File tab. 

 
Preferences -> File 
 
Here you can configure if you want column headings to appear in your output and whether they should 
appear on multiple lines (similar to how they appear in iDoctor or not.) 
 
Next for a table view, you would use the Save button on the toolbar to create a .csv file for use with Excel. 

 
Save As button on Data Viewer toolbar 
 
Note: This can be a time-consuming operation.  It is best to only do this with reasonably small data sets 
or this could take an extremely long time. 
 
For a graph view, click the button to show the table below the graph. 
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Next click on the table below the graph (anywhere, so it has focus), then click the Save as button like 
before to export the graph’s data to a .csv file for use with Excel. 
 
Return to Common Problems 
 

4.13 I am getting ‘Statement contains wrong number of 
values’ when trying to list collections with client 1570+ 

This means the table QUSRSYS/QAIDRCOLS is outdated and must be updated to work with the version 
of the GUI you are using.  This can be resolved by reinstalling the server builds. 
 
If you wish to avoid reinstalling server builds, then someone needs to do these steps once per LPAR:  
 
1. Open Job Watcher (do not expand libraries) 
2. From the Job Watcher icon right-click and take the Collections Database -> Check for locks menu 
option.  If any locks then end those jobs by selecting all jobs, right-click Active job options -> End Job 
immediate 
3. Then from the component icon right-click Collections Database -> Full Rebuild. 
 
Return to Common Problems 
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5 Collection Services Investigator 

Return to Top 

5.1 What is Collection Services Investigator? 
Collection Services Investigator (CSI) provides graphs and other analysis functions for looking at IBM i 
performance data over the Collection Services data typically collected on an IBM i.    
 
CSI is included with a Job Watcher license. 
 
Return to Collection Services Investigator 
 

5.2 How do I graph multiple days of data at once? 
In order to graph multiple days / collections of data follow these steps: 
 
1.  (Optional) Run the Collection Summary analysis on all collections you wish to graph.  Right-click the 
collection’s -> Analyze -> Run Collection summary menu.   
 
Note:  This is recommended and should be done for all collections.  You cannot graph multiple days of 
data if only some are summarized and some are not. 
 
2.  Select all collections you wish to graph within the library.   
 
3.  Right-click the selection and pick the graph of your choice.  You will be asked if you wish to combine 
the data into a single graph.  Click Yes 
 

 
Example of how to graph multiple collections in Collection Services Investigator 
 

http://public.dhe.ibm.com/services/us/igsc/idoctor/html/CSI.html
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Graph multiple collections prompt 
 
Tip: Clicking 'No' above would cause 2 graphs to be opened instead (one for each collection.) 
 

 
Collection overview time signature showing 2 collections 
 
In the graph where you see vertical dashed lines, this indicates that a break in the data where a new 
collection is being shown.   
 
Tip:  Use the clock icon in the toolbar to set the interval size to 1-hour groupings (or higher) if there are 
many bars for easier readability of multiple days of data. 
  
Note:  Instead of the above steps the Historical Summary analysis can be ran against a library (which 
summaries the data in all collections in the library).  This also makes it easier to graph data over several 
days, weeks or possibly months. 
 
Return to Collection Services Investigator 
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5.3 When listing collections, I see the message Missing 
required data: QIDRGUI/QAIDRPCRM? 

This message will appear if you are using an older iDoctor server build with a newer client build (1381 or 
higher.)  This new table is required now in order to show the Collection overview time signature at 7.2+ 
with the new Expected CPU rate metric. 
 

 
Example list of collections in Collection Services Investigator 
 
This can be resolved by either running the Create QIDRGUI/QAIDRPCRM analysis for any collection on 
the system (one time) or reinstalling the latest server builds. 
 
Note:  The table QIDRGUI/QAIDRPCRM contains data from the various IBM i Power Systems 
Performance Capabilities Reference documents.  These are listed on our website at: 
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsDemos.html 
 
Attempting to open iDoctor graphs anyway with this status message present will result in an error like this: 

 

 

Return to Collection Services Investigator 

5.4 What is Expected CPU rate? 
This iDoctor-exclusive metric is found on the Collection Overview Time Signature graph in Collection 
Services Investigator and is an indicator of whether the CPU is running at a typical speed based on 
several factors like the processor’s nominal speed, power mode, processor feature and min/max 
frequency.   
 

http://public.dhe.ibm.com/services/us/igsc/idoctor/html/downloadsDemos.html
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With Power 9 systems are often shipped by default with the power mode set to maximum.  In this case it 
is normal to have a high CPU speed and the expected CPU rate will likely be over 100% (if not and the 
power mode is set to maximum then this could indicate a problem.).    

 
Power 9 system with power mode set to maximum 
In the above example Expected CPU rate is listed at around 105% while Average CPU rate is about 
120%.  This is an example of a normal scenario. 
 
At Power 7 and Power 8 systems are set to nominal power mode by default.   In this case, the Expected 
CPU rate will be about the same as the Average CPU rate.  They will differ only in situations where the 
nominal CPU speed listed in QAPMCONF by Collection Services for this system is different than the 
PCRM documented value for nominal speed for this system.   
Return to Collection Services Investigator 
 

5.5 What is Average CPU rate? 
Average CPU rate is included on the Collection Overview Time Signature and is an indication of how hard 
the CPU is running based on the power mode setting of the system and the current system activity.  This 
value is also listed in WRKSYSACT.  It is defined there as: 

 
WRKSYSACT – Average CPU rate  
 
On Power 9 if the power mode setting is set to maximum, then this value is generally higher than 
Expected CPU rate.  On Power 8 and Power 7 the Average CPU rate value generally matches Expected 
CPU rate.  
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Note: In the past this column was named “CPU power-savings rate (Scaled CPU: Nominal CPU)" and 
was renamed to Average CPU rate in client 1365. 
 
Return to Collection Services Investigator 

 

5.6 What is Situational Analysis? 
Situational Analysis is a function in iDoctor that looks for performance problems in a collection based on 
issues encountered in the past in various real-world customer problems.  If situations (problems) are 
found in the data, they will be highlighted on the collection’s high level (over time) graphs.   
 
Each situation has a problem description and resolution description and is given a background color in 
the graph.  When situations are found instead of the graph’s background being white it will be the color 
assigned for the situation.  If multiple situations are found in a time interval, then that color is always red. 
 

 
An example of a graph with 3 situations but only 1 visible currently 
 
To control which situations are visible on the graph simply click the name of the desired situation in the 
top right corner of the graph legend.  You can also click None to hide all situations if there are too many 
and it becomes over whelming.  
 

 



IBM iDoctor for IBM i  

Graph Legend situations section example 
 
Return to Collection Services Investigator 
 

5.7 When opening graphs I see the error HEXTOBINT in 
*LIBL not found? 

This SQL function should have been created when iDoctor was installed.   
 

 
HEXTOBINT in *LIBL error 
 
A work around would be to try running these commands in an SQL editor of some sort (iDoctor's would 
work or STRSQL, RunSQL Scripts/etc) and the issue should resolve itself.  
 
create OR REPLACE function qidrgui/hextobint (VARCHAR(16))     
 returns BIGINT                                      
 LANGUAGE C                                          
 external name 'QIDRGUI/QIDRUDFS(HEXTOBINT)'         
 Parameter style general                             
 NO SQL                                              
 DETERMINISTIC                                       
 RETURNS NULL ON NULL INPUT                          
 NOT FENCED; 
 
  GRANT EXECUTE    
    ON SPECIFIC FUNCTION QIDRGUI/HEXTOBINT 
    TO PUBLIC; 
 
If problems persist, then rerun the iDoctor installation on the server.  If errors occur or the problem 
remains then we will need the setup log sent to us which typically you could find this in C:\program files 
(x86)\ibm\idoctor\setuplogs\setup_<yoursystemnamehere>.log 
 
Return to Collection Services Investigator 
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6 Job Watcher 

Return to Top 

6.1 What is IBM iDoctor for IBM i Job Watcher? 
Job Watcher is a performance analysis tool in the iDoctor tools suite that provides summarized and 
detailed job statistics including wait bucket statistics.  It also includes information such as holding jobs, 
wait objects and call stacks that are very useful for solving many performance problems on IBM i. 
 
Return to Job Watcher 
 

6.2 What are the software requirements for running the 
server code of Job Watcher? 

At 6.1 and higher, the Job Watcher commands are included with IBM i. However, it is strongly 
recommended to ensure the required Job Watcher PTFs are up to date before running collections. 
 
PTF information is listed on our website.  Other requirements are listed in the documentation for installing 
Job Watcher. 
 
Return to Job Watcher 
 

6.3 How do I get started using Job Watcher? 
The best place to start is the Video Library page to view videos of how to use the tools.  
 
The documentation also provides information about how to use the tools. Education is also available via 
one of our on-site customer workshops. 
 
Return to Job Watcher 
 

6.4 How do I graph multiple collections at once? 
To graph multiple collections, follow these steps: 
 
1.  (Required, if not already completed.) Run the Collection Summary analysis on all collections you wish 
to graph.  RIght-click the collections -> Analyze -> Run Collection summary menu.   
Note:  You can tell if this is done by looking at the column "Using iDoctor Collection Summary" and 
looking for a value of Yes.  
 
2.  Select all collections you wish to graph within the library.   
 
3.  Right-click the selection and pick the graph of your choice.  You will be asked if you wish to combine 
the data into a single graph.  Click Yes 
 

http://public.dhe.ibm.com/services/us/igsc/idoctor/html/JW.html
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/ptfs.html
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/documentation.html
https://mediacenter.ibm.com/channel/iDoctor/200077473
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/documentation.html
http://public.dhe.ibm.com/services/us/igsc/idoctor/html/services2.html
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Example of graphing multiple collections in Job Watcher 
 

 
Graph multiple collections prompt 
 
 
Return to Job Watcher 
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7 PEX Analyzer 

Return to Top 

7.1 What is PEX Analyzer? 
The PEX Analyzer component of iDoctor is an in-depth performance analysis tool that provides highly 
detailed reports (called analyses) over many different types of PEX data. PEX Analyzer consists of data 
collection and manipulation programs on the server-side and friendly, easy-to-use graphical interfaces 
over the performance data on the client side. The data can be manipulated in various ways to help find 
and diagnose performance problems effecting your System i. 

Return to PEX Analyzer 

 

7.2 What are the software requirements for running the 
server side of PEX Analyzer? 

PEX and DB2 are required but these are included with IBM i.  General iDoctor IBM i requirements are 
listed here. 

Return to PEX Analyzer 

 

7.3 Can I use the PEX Analyzer software to analyze data on 
all servers in my enterprise? 

Yes.  A single installation of PEX Analyzer can be used to analyze data collected on other systems. What 
you will not be able to do is collect the data on other systems via iDoctor's commands 
(QIDRPA/STRPACOL) or by using the iDoctor GUI.  This means any PEX data you collect on these 
systems without PEX Analyzer access, must be collected using IBM i commands: ADDPEXDFN, 
STRPEX, ENDPEX instead. 

Return to PEX Analyzer 

 

7.4 I understood Performance Explorer, PEX, to be part of the 
operating system so what exactly is PEX Analyzer? 

Performance Explorer or PEX, is indeed part of the base IBM i operating system. The necessary 
commands to collect PEX data are shipped with the base operating system.  What PEX Analyzer 
provides is an easy-to-use collection facility, and a GUI client constructed from years of built-in 
experience and function based on "real-world" requirements. These "real-world" requirements are the 
results of work on the toughest problems that the IBM i Global Support Center has worked on and 
resolved. It is one of the reasons we feel so strongly that it's the best problem-solving tool available on the 
market today.    
 
We typically start with Collection Services and/or Job Watcher data first and then if the problem cannot be 
solved, we turn to PEX Analyzer to solve the toughest problems. 
 

Return to PEX Analyzer 
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7.5 I want to learn more about PEX and performance 
analysis. Are there any courses available? 

For hands-on educational assistance, you may request one of our iDoctor workshops.   
 
More information is provided here. 

Return to PEX Analyzer 

 

 

 

http://public.dhe.ibm.com/services/us/igsc/idoctor/html/services2.html

